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Getting the most out of 
Google Workspace.

http://www.copper.com
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You use Google apps to level up your 
team’s productivity — but you can also use 
it to collaborate and communicate better 
with your prospects and customers. We’ve 
distilled the most actionable steps to help 
you get the most out of Google Workspace 
and surface some of the lesser-known 
features that will keep you and your team 
effortlessly organized — and on top of your 
game. 

We’ll walk you through the most popular 
Workspace apps, with tips that streamline 
workflows and help you develop meaningful 
relationships with your contacts, colleagues 
and prospects.

http://www.copper.com
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of their working day reading 
and replying to emails, found 
McKinsey.

28%
The average American professional spends

A large slice of that time goes to waste — 
especially when inboxes lack organization. 

per day, a Harvard Business 
Review article estimates.27 mins

The simple task of getting organized in Gmail 
can drastically cut down on time wasted 
wandering around your inbox.

Ordering and 
organizing Gmail for 
optimal performance.

Case in point: A crowded inbox leads to an 
unproductive

http://www.copper.com
https://www.mckinsey.com/industries/high-tech/our-insights/the-social-economy
https://hbr.org/2019/01/how-to-spend-way-less-time-on-email-every-day
https://hbr.org/2019/01/how-to-spend-way-less-time-on-email-every-day
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Out of the box, Gmail offers:

•	 An intuitive experience for organizing your 
inbox and sending emails

•	 Direct integrations with the rest of Google 
Workspace so you can easily send Google 
Drive files and Google Calendar invites via 
email

•	 An option to access previously loaded 
emails when you’re on a plane or 
anywhere else offline

•	 Secure access to key conversations 
happening through email

•	 Sophisticated filtering to keep spam away

 
We’re just scratching the surface here. Get 
the most out of Gmail with the tips on the 
following pages:

You can also use your CRM as an 
added layer of organization, to 
automatically designate which emails 
are related to a specific deal or other 
key organizations within your account-
based marketing strategies. More on 
that later, or jump to that section now.

CRM 
TIP

http://www.copper.com
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Add filters for important 
contacts

To ensure high visibility for key contacts 
in your inbox, you can automatically tag 
incoming messages from specific contacts 
as important or add them to designated 
inbox folders with filters.

To add a new filter, click on the gear icon in 
the top right-hand corner > See all settings > 
Filters and Blocked Addresses:

STEP 1

When you click Create a new filter, this pop-
up appears:

Let’s say you want to automatically “star” 
all messages from fiona.thornglie@gmail.
com. Just add her email address to the From 
field. Then, on the next page, apply the filter 
setting Star It.

http://www.copper.com
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See your starred messages first by auto-
sorting your inbox.

Auto-sort messages by 
importance

Go to Settings > Inbox and choose Starred 
First or any of these other options:
•	 Importance (make sure to enable the 

Importance markers below)
•	 Read status
•	 Priority

Here’s how starred sorting looks with any 
starred items shown up top in your inbox:

STEP 2

http://www.copper.com
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Yes, you can undo an email send, if you 
time it quickly enough. By default, the Undo 
button will appear in Gmail when you send 
an email, but there’s only a 5-second window 
for you to act. Thankfully, you can adjust 
your settings to allow a little more breathing 
room for those times when you hit Send 
prematurely.

Click on the gear icon in the upper right-
hand corner and select See all settings from 
the left-hand menu:

Give yourself more time to 
recall an email

STEP 3

Once you’re in settings, scroll down to the 
option that says “Undo Send.” You can 
choose to show the Undo button for 5, 10, 
20 or 30 seconds after your email is sent.

Giving yourself a 30-second window might 
just save future you from an embarrassing 
faux-pas.

Read our full guide on recalling an email

http://www.copper.com
https://www.copper.com/resources/how-to-recall-an-email-in-gmail
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Push distractions out of view by updating 
your inbox settings.

Move social and promotion 
emails out of sight

Go to your Settings and click on Inbox. 
Then select Social, Promotions and other 
category options based on the messages 
you’re subscribed to, but don’t need to see 
during the workday.

These emails then split off into other tabs so 
you can focus on your primary messages.

STEP 4

http://www.copper.com
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Create reminders for yourself to follow up 
with contacts or complete any assignments.

Open a message in Gmail you want to add a 
task or reminder for. Click Add a task.

Schedule tasks

STEP 5

CRM 
TIP

Using a CRM with built-in reminder 
and task options inside Gmail can 
help you prioritize without a second 
thought. More on that later, or jump 
to that part now.

http://www.copper.com


www.copper.com   |  122021 YOUR GOOGLE WORKSPACE DEEP DIVE

It’s always nice to have one less browser 
window open. Add software your team 
already uses into Gmail to save time.

To install these apps, go to Settings >  
Add-ons > Manage

Accomplish more in Gmail 
by integrating with other 
software

STEP 6

Then search for your preferred tools, whether 
it’s Zoom or your CRM. Zoom, for example, 
lets you easily start, schedule, and view 
upcoming meetings from inside your inbox.

http://www.copper.com
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STEP 7

You likely send some tried-and-true emails 
to follow up with leads. Or you may send 
specific emails every time you onboard a 
new customer.

Enable templates by going into Settings > 
Advanced.

Save time with templates

CRM 
TIP

You can upgrade your team’s 
productivity and knowledge share 
when your CRM integrates smoothly 
with Gmail. 

With Copper, easily import your 
Google Contacts and mobile-device 
contacts for a full record of your 
communication history directly 
alongside Gmail with the Copper 
Chrome Extension, and within the 
Copper CRM web app. You can then 
organize your contacts by relationship 
type so that your entire network 
makes more sense. More on this later, 
or go to that section now.

http://www.copper.com
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You’ll now see an option for templates in 
new messages.

Then you can:
•	 Save any draft as a new template
•	 Insert a premade response into any draft
•	 Delete any template you no longer need

Just remember to clearly name each 
template so they’re easy to find.
 
And if you’re a Copper customer, we offer 
more robust template options that save you 
even more time personalizing your outreach 
and sending emails. More on this later. 
 
We’ve got even more tips for you: Learn how 
to add a logo to your Gmail signature and get 
other Gmail hacks here.

http://www.copper.com
https://www.copper.com/resources/how-to-add-signature-in-gmail-with-logo
https://www.copper.com/resources/how-to-add-signature-in-gmail-with-logo
https://www.copper.com/resources/gmail-hacks
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Organize and grow  
your network with 
Google Contacts.

Google Contacts lets you easily:

•	 Search contacts by name or email address
•	 Add phone numbers, notes, job title and 

the company associated with any contact
•	 Update contact information when 

their email address, phone number or 
organization changes

•	 Merge duplicate contacts so your team 
has a single record to manage a client’s 
contact information

Let’s look at a few Google Contacts hacks.

Managing your work contacts is one of the 
easiest ways to help your team function more 
efficiently.

http://www.copper.com
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Whether you send weekly reports to specific 
customers or you want to email your team 
and ensure everyone gets the message, 
create contact groups so you can repeatedly 
send emails to specific people. 

In the Contacts home screen, select 
Create label from the left-hand column. 
Label it however you’d like. Then you can 
select multiple contacts and label them 
accordingly.

Save time sending  
group emails

STEP 1

http://www.copper.com
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You can bring down your total contact count 
(Google limits your contacts to 25,000) 
by getting rid of unnecessary duplicates. 
Google Contacts has a handy algorithm that 
suggests possible duplicates.

Merge duplicate contacts

In Contacts, click Merge & fix to see their 
suggestions. 

STEP 2

If you spot any other duplicates scrolling 
through your contacts, you can also click 
the box next to each. Then select the merge 
icon.

http://www.copper.com
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Nurture your customers, leads and other 
contacts for the long term by syncing your 
CRM with Google Contacts. A CRM like 
Copper that integrates natively with Google 
Workspace makes growing your network a 
smooth process.

When you click the Copper icon in your 
inbox, you can add anyone as a contact or 
lead to Copper. Copper’s Google Contacts 
integration offers a one-way sync that 
applies the changes made in Copper to your 
Google Contacts. By adding a new contact 
to Copper or updating an existing contact, 
you’ll also add or update a contact to Google 
Contacts.

Sync your CRM to Contacts

STEP 3

http://www.copper.com
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Construct a  
crystal-clear schedule 
with Google Calendar.

With Google Calendar, you can:

•	 Schedule meetings and events
•	 Add a location, agenda and link to a 

conference call in any invite
•	 Send everyone an automatic reminder of 

an upcoming calendar event
•	 Automatically send calendar invites, 

reminders and updates when events 
get canceled, moved, or have agenda 
changes

Let’s dig into key Calendar hacks you can 
turn on right now.

Juggling business and personal 
commitments can sometimes feel like 
mayhem, not to mention your ever-
fluctuating schedule. Google Calendar  
can help keep you sane.

http://www.copper.com
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Set a better default 
calendar view

By default, your Google Calendar shows the 
current week. But the way you work will help 
determine the timeline and calendar view 
that work best for you.

For example, you may be responsible for 
managing projects, so a month view makes  
more sense. Or you like to be laser-focused 
on the tasks at hand, so you prefer seeing 
what’s on your schedule today.

STEP 1

Set a default calendar view that works 
for your schedule under the following 
dropdown:

http://www.copper.com
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Quickly check a specific 
timeframe
Let’s say you’re on a call and want to get 
a follow-up meeting with someone on the 
books. You can easily see your availability 
and upcoming meetings for any range of 
dates instead of having to click into specific 
weeks or days. 

Simply use the calendar widget on the left 
in Google Calendar. Click the first date you 
want to see and drag the mouse to highlight 
as many other dates you want to include in 
the view:

STEP 2

To return to single-day view, click the 
dropdown menu at the top right that shows 
what view you’re seeing, and select Day.

http://www.copper.com
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Color-code your calendar

Color coding lets you clearly organize your 
calendar and quickly see how your workdays 
break down.

In Google Calendar, there are two ways to do 
this: The first involves adding a color code 
when you create a new event. If you work 
from home or just want a clearer view of 
your commitments, structuring and color-
coding your schedule and breaks can help.
 
For example, by labeling your midday 
workouts red and lunch breaks blue, your 
calendar could look like the image on the 
right.

Consider also color-coding your schedule 
based on the urgency of tasks.

STEP 3

http://www.copper.com
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Another way you can color-code your 
schedule involves creating different 
calendars. With a dedicated meetings 
calendar, you can add any upcoming 
sessions within that calendar when you send 
out invites. 

To create a new calendar, click the gear icon 
to open your Calendar settings. Click Add 
calendar > Create new calendar. After you 
save, navigate back to the main calendar 
page, and hover over your new calendar to 
select a new color.

In the right example, you can see five 
calendars that appear in the left-hand 
sidebar, with a color assigned to each. Events 
within those calendars will automatically 
feature different colors.

http://www.copper.com
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Find an event in seconds

STEP 4

Most people don’t realize you can search 
calendar events. Just click the search icon 
in the top navigation of your Calendar. Type 
in any word associated with the invite to 
retrieve the event.

http://www.copper.com
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Never miss a meeting

Avoid missing important meetings by 
customizing how you receive event reminder 
notifications.

Click Settings up top. From the left-hand 
menu, select a specific calendar to update 
its settings.

Scroll down to Event notifications. You can 
set up notification receipts that pop up 
on the corner of your screen (or as a push 
notification on your phone). Or if you want 
email reminders, select that option. Next, 
choose how far ahead of an event you want 
to receive a reminder.

STEP 5

Click +Add notification if you want to receive 
notifications through more than one method. 
Then add notification settings to get 
notifications for all-day events.

You’ll never need to add a reminder manually 
again; these updates apply to all future 
events on your calendar.

http://www.copper.com
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Add all attendees to your 
CRM for easy follow up
Expand your network effortlessly with 
Copper’s native Google Calendar integration: 
You can add Google Calendar event 
participants to Copper CRM with one click 
using the Copper Chrome extension. Don’t 
worry, we’ll get more into this later.

STEP 6

Get even more Google Calendar hacks here: 
30 Google Calendar hacks to boost your 
productivity

http://www.copper.com
https://www.copper.com/resources/google-calendar-hacks
https://www.copper.com/resources/google-calendar-hacks
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Collaboratively track 
your data using Google 
Sheets.

Google Sheets lets anyone on your team: 

•	 Review and collaborate on spreadsheets in 
a secure space

•	 Track changes and add comments as 
updates occur and revert to previous 
versions if needed

•	 Create formulas, filters and pivot tables to 
make data-driven decisions

•	 Avoid data silos; easily import information 
from another source via a CSV file

•	 View and organize the information you 
receive from Google Forms

•	 Visualize your team’s results so anyone you 
present to can quickly interpret the data

Keep these tips in mind to help you slice and 
dice data in Google Sheets:

Let’s take a second to celebrate the end 
of storing 20 similar versions of the same 
spreadsheet on your computer.

http://www.copper.com
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Some data that’s helpful to you for number 
crunching may be less relevant to teammates 
when you’re sharing the spreadsheet with 
them.

Hide data

In Google Sheets, you can hide columns and 
rows by right-clicking on either and selecting 
Hide.

To unhide, look for the arrow icon next to 
where that row or column once displayed. 
Hover over the arrow until you see a white 
box framing it. Then click to show that data.

STEP 1

http://www.copper.com
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Don’t worry about having to remember what 
each row or column contains when you 
scroll. You can freeze rows and columns so 
their names always show.

Select View > Freeze > the number of rows 
and columns you want. 

Freeze rows and columns

STEP 2

http://www.copper.com
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Automatically apply formatting to any cell in 
your spreadsheet based on any condition. 
For example, Sheets can automatically 
highlight a cell in green when the potential 
value of a deal is over $10,000.

Select Format > Conditional Formatting. 
Under “Format cells if…”, select “Greater 
Than”, then type 10,000 as the value.

Set conditions

STEP 3

http://www.copper.com
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Stay connected and tuned 
in with Google Meet.

Run through your sales deck in a video 
meeting while still reading nonverbal cues 
from your potential clients. Host remote one-
on-ones. Organize and run a video meeting 
any time from mobile or desktop. 

Best of all, Meet can run straight from your 
desktop browser, so you don’t have to deal 
with slow loading times and managing 
settings in a separate app. 

Here are our top hacks for getting the most 
out of Meet:

With Google Meet, start impromptu 
brainstorm sessions, client meetings, team 
huddles and more.

http://www.copper.com
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Use keyboard shortcuts

Some shortcuts that can help you run 
meetings more effectively include:

Mac Windows

Turn your camera on or off Cmd + E Cmd + E

Mute or unmute your microphone Cmd + D Cmd + D

Display the current users Ctrl + Cmd + P Ctrl + Alt + S

Announce who is currently speaking Ctrl + Cmd + S Ctrl + Alt + P

STEP 1

http://www.copper.com
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Adjust the video resolution

If you’re working from somewhere with a 
slow internet connection, updating your 
resolution settings can help keep the 
meeting running smoothly.
 
Click > Settings > Video. Adjust your send 
and receive resolution to 360p. In case 
your video still lags, consider running or 
participating in the meeting on audio-only.

Add a blurred background in Google 
Meet to minimize distractions so viewers 
can focus on the content of what you’re 
saying and not your cat sunbathing in the 
background.  
 
Click     > Apply visual effects. You can 
select from a blurred or slightly blurred 
background, depending on your preference.

Blur your background

STEP 2 STEP 3

http://www.copper.com
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Record your call
Record team meetings so you and 
collaborators can go back and reference 
them after the fact. Plus, if someone isn’t 
able to attend, they can watch and catch up.

Click     > Record meeting. A righthand 
column will pop up with a Start recording 
button (click the button).

Google Meet will notify everyone when you 
start recording. Remember to give people a 
heads up before clicking this option.

STEP 4

CRM 
TIP

Quickly prep for your Google Meet 
events with Copper inside Google 
Calendar. View context around 
meeting participants, including 
communication, files and activities, 
and even add new meeting attendees 
to Copper with one click for easy 
follow up. More on this feature here.

http://www.copper.com
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Find, store, and share 
all your files with 
Google Drive.

With Google Drive, teams can:
•	 Store, retrieve, and share files in an instant
•	 Keep track of the most up-to-date version 

of a file
•	 Securely manage who can view and edit 

anything saved in Drive
•	 Automatically scan files for sensitive 

information and block anyone outside your 
organization from accessing a file

 
Here are a few key productivity tips for using 
Drive:

Life’s too short to waste time hunting down 
files. Google Drive helps keep teams and 
companies organized and on the same page 
through a robust cloud storage system built 
around collaboration.

http://www.copper.com
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Make finding files easier for all your co-
workers by building out an organized shared 
drive. 

If you haven’t already created a shared drive, 
select Shared Drives from the left-hand 
menu in Google Drive. Then click +New and 
enter a Name for the new drive.

Create a shared drive for 
your team

STEP 1

Establish the shared folders’ organization 
based on the project, client, campaign or 
anything else that makes sense around your 
team’s frameworks.

PRO 
TIP

Insert a description for Drive files 
and folders to provide additional 
information to your team. Select any 
file or folder, then click View Details. 
Under Details, scroll down to add a 
description.

http://www.copper.com
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Stay in the loop on updates, new files and 
comments using Google Drive notifications. 

Click Settings > Notifications and select 
browser, email or even Slack notifications.

By default, you receive email notifications.

Turn on notifications

STEP 2

If you want push notifications, make sure to 
enable them in the browser first.

With browser notifications, you can specify 
which ones you want to receive.

Since push notifications will interrupt you as 
you work in the browser, you may only want 
to allow the most urgent communications to 
come through that way.

http://www.copper.com
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Google Drive supports 100+ file types. 
Simply drag and drop anything saved on 
your computer into any folder your team has 
in Google Drive (or click My Drive > New 
folder to create one).

You can upload entire folders too.

Save all your files

STEP 3

http://www.copper.com
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Don’t waste half an hour trying to locate a file 
— Drive’s search function can help.

Basic search only allows you to locate certain 
words in files or image names. Sure, you 
could narrow down the options slightly by 
selecting the file type (if you remember what 
it is)... 

A more robust option is to click into the 
search bar and select More search tools. 
You’ll unlock advanced search capabilities 
here.

This feature is helpful for not only quickly 
locating files you’re struggling to find, but 
also pulling up a list of specific results.

Conduct more specific 
searches

For instance, you’d be able to look for Docs 
owned by you and created after a specific 
date.

STEP 4

http://www.copper.com
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To access Google Drive’s apps, go to your 
Settings and locate the Manage Apps tab:

As you can see, there are already a few apps 
installed to streamline work between Google 
and other platforms.

Do more with Google Drive 
files using Apps

STEP 5

http://www.copper.com
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Here are a few apps that may help you 
manage files and save your team time:

•	 PDF Converter Online: Convert PDFs into 
other document types

•	 DocuSign: Sign, merge, or edit PDFs
•	 Optimizer: Optimize images
•	 Video Converter: Convert videos
•	 Lucidchart: Create collages, graphics and 

other design files
•	 Moqups: Build storyboards or wireframes
•	 Slack: Communicate and collaborate with 

teammates
•	 Zapier: Automate processes and connect 

apps with no code required

Click on Connect more apps to bring other 
helpful tools into the mix. 

There are hundreds of apps you can connect 
to Drive. Your best bet is to search based on 
what you’re looking to get done.

http://www.copper.com
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Get useful insights to 
take the right actions 
with Google Forms.

Forms can also help you get feedback on any 
internal initiatives by quickly spinning up a 
survey and sending it to your team. 
 
Google Forms lets you:

•	 Create as many surveys and forms as your 
team needs

•	 Easily add open-ended and multiple-
choice questions

•	 View information entered by anyone who 
completes your form in Google Sheets

•	 Indicate required fields in your form so you 
can qualify prospects 

Let’s look at two features that are especially 
helpful in Google Forms.

Spending ten minutes creating a form can 
save you hours of unnecessary back and 
forth with clients or heading down a rabbit 
hole with an unqualified lead.

http://www.copper.com
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Stay in the loop

Receive notifications when new form 
submissions come in. From the editable 
version of your form, click Responses >     > 
Get email notifications for new responses.

STEP 1

http://www.copper.com
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Share a pre-filled link

You may have discussed certain details 
already with a prospect, but you still need 
to gather more information. Share a partially 
completed client intake form. 

Click     from the top right of your form and 
select Get pre-filled link. 

STEP 2

A new browser tab will open up where you 
can partially fill out the form based on what 
you already know. Click Get link when you’re 
done so you can share it with your client.

http://www.copper.com
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Pitch like a pro with 
Google Slides.

Google Slides gives you the keys to:

•	 Create and collaborate together on 
presentations

•	 Comment and chat about specific items in 
slides to fine-tune your presentation

•	 Work off existing templates and save new 
ones so creating future presentations 
takes less time

•	 Track revisions and revert back to a 
previous version

•	 Convert Powerpoint files to Slides so all 
your team’s presentations are in one place

•	 Easily present slides on video calls or in-
person through Chromecast 

Here are five tips that can save your team 
time working in Slides:

Closing deals. Reporting results. Sharing the 
latest news during your team meetings.

http://www.copper.com
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As you’re tweaking sales decks for specific 
clients, you can ensure no one on your team 
overwrites the base template file. Name it 
something clear such as “Master File” or 
even put in parentheses “MAKE A COPY”.

Then anyone on your team can click File > 
Make a copy to duplicate and tweak.

Make your base template’s 
file name clear

STEP 1 STEP 2

If you need to pull slides from one file to 
use in another Slides presentation, File > 
Make a Copy has an option where you can 
select specific slides to add into a new file. 

You can also select a specific slide and 
click Cmd (Ctrl) + C to copy. Then go into 
the other presentation and paste with Cmd 
(Ctrl) + V.

Copy specific slides into 
another presentation

http://www.copper.com
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Make sure your talking points are clear by 
capturing them as you dictate out loud.

First, double check that your computer 
microphone is on and working. Microphone 
settings are typically in the System 
Preferences on a Mac or the Control Panel 
on a PC.  

If you’re not yet using Chrome’s browser, 
open your Slides presentation in Chrome 
to use dictation. Click Tools > Voice type 
speaker notes. A menu will pop up where 
you select Click to speak.

Dictate notes
Chrome will also ask for access to your mic 
to capture your voice notes. Voice dictation 
is available in many other Google apps too, 
we just happen to love using it for Slides.

STEP 3

http://www.copper.com
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Flag typos
Don’t let one typo undermine an 
otherwise great presentation. Click 
Tools > Spelling > Underline errors 
to quickly spot potential spelling or 
grammar errors.

STEP 4 STEP 5

If your team meeting presentations are 
starting to look stale, consider using image 
masking. Image masking lets you take any 
image and apply a shape crop to it. Simply 
select an image and then click Mask Image 
icon from the Crop tool, and select a shape 
for the mask.

Add Image Masking

Here’s the image with rounded edges:

http://www.copper.com
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Elevate your team’s 
productivity with the Copper 
Chrome Extension.

If you haven’t already, download the Copper 
Chrome Extension. Copper sits right inside 
your Gmail inbox and Google Calendar so 
you can stay on top of all your relationships. 

Like the moon landing, getting started with 
Copper is one small step for you, but one 
giant leap in your team’s journey to become 
more productive.

http://www.copper.com
https://chrome.google.com/webstore/detail/copper-crm-for-gmail/hpfmedbkgaakgagknibnonpkimkibkla
https://chrome.google.com/webstore/detail/copper-crm-for-gmail/hpfmedbkgaakgagknibnonpkimkibkla
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After you install the Copper Chrome 
extension, getting up and running 
begins with your contacts. Anyone you 
email who isn’t already a lead or person 
in Copper will be sent to a Suggested 
Contacts section in your dashboard. 
The Chrome extension searches across 
the internet for your contact’s company 
name, website and other key details, 
providing you with additional context 
and eliminating data entry while you add 
them to Copper. 
 
Once new contacts have been added, 
any interactions between you, your team 
and the contact sync to their contact 
record, and will appear in the Chrome 
extension alongside your inbox and 
calendar. Emails from the last year will 
also show in the interaction history. That 
way, everyone stays on the same page.

Getting the most out of the 
Copper Chrome extension
The Copper Chrome extension goes beyond 
syncing and displaying your upcoming deals. 
It also helps streamline your workflow and 
eliminate tab-switching. Here’s how:

http://www.copper.com
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Inboxes can feel noisy and cluttered. 
Filtering through and determining priority 
emails that matter can consume a lot 
of precious time. The Copper Chrome 
extension automatically spotlights your 
tracked emails using the Copper icon, so 
you and your team can easily surface the 
emails that can drive growth and nurture 
your business relationships.

You likely have emails that perform 
particularly well during outreach, and find 
yourself copying, pasting, and then slightly 
tweaking them with every new prospect. In 
Copper, you can save them as templates so 
you don’t have to waste time sending routine 
emails like customer or new-hire onboarding.

Copper templates can also be shared across 
your team and include merge fields to 
automatically personalize greetings.

Zero in on the emails that 
matter.

Take back hours drafting 
repeat emails.

01 02
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03 04

You won’t need to struggle to stay on top of 
your important tasks. Whether your current 
workflow involves using your inbox as a to-
do list, switching to another tool in another 
tab, or referencing sticky notes covering 
your desk, it all takes work to maintain. 
With the Copper Chrome extension, you 
can create tasks and follow-up reminders 
directly within an email. From there, they’ll 
surface to your dashboard and schedule 
themselves to your calendar.

The Copper Chrome extension also helps 
keep your Copper app up-to-date to serve 
as a reliable single source of truth for 
your organization. If your legal or billing 
departments are interacting with their 
counterparts at an organization you’re 
responsible for, they can add a conversation 
to an Opportunity, Company or Person 
record from the Chrome extension with one 
click.

Unify your inbox, to-do list 
and CRM.

Make your CRM your single 
source of truth.

http://www.copper.com
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The Copper Chrome extension is integrated 
with Google Calendar, so you and your team 
can easily view event details, participants 
and materials. Plus, you can one-click add 
anyone as a Copper contact that’s part of 
an upcoming Calendar event. This enables 
easy follow up and relationship building with 
new contacts in a customer or prospect’s 
organization.

No one needs to break their workflow 
to learn more about event attendees — 
just click on their names to see any past 
interactions between them and your team.

And with Meeting Scheduler enabled, 
you can quickly send meeting invites to 
customers and prospects and allow them to 
pick any open slot on your calendar (learn 
more here).

05

Add new meeting attendees 
directly from Google 
Calendar with one click.

http://www.copper.com
https://support.copper.com/hc/en-us/articles/360000668791-Setting-up-and-using-Meeting-Scheduler
https://support.copper.com/hc/en-us/articles/360000668791-Setting-up-and-using-Meeting-Scheduler
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More reasons teams  
love Copper.

Quickly see the big picture

Track leads along a visual pipeline 
and review how long deals remain in 
different stages before closing. From 
the Dashboard on the Copper web app, 
select Opportunities to check out a tile-
style view of your pipeline.

Once you have a clearer idea of where 
leads spend the most time, you can fine-
tune processes, identify friction points, 
and more effectively drive your most 
important deals forward. 

01

After the deal is closed, Copper’s 
Projects functionality allows a seamless 
handoff and better collaboration across 
your business.

http://www.copper.com
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0302

Associate files with contacts

A sales proposal. An executed 
agreement. Onboarding docs. Tie any 
of these Google Drive files to a specific 
contact using Copper. That way, 
everyone on your team can easily retrieve 
files, enabling you to more effectively 
manage those key relationships.

Sync from every device

On top of syncing from Google Contacts, 
contacts from your mobile device can 
also be synced using the Copper mobile 
app. This lets you view communication 
between your teammates and any saved 
contacts while on the go. You can also 
add notes, log calls, attach files and 
pretty much anything else you need to 
provide more context, even while you’re 
not at your desk.

http://www.copper.com
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Connect Copper 
with even more apps 
through Zapier.

Zapier is an automation platform that lets you 
connect apps together in your tech stack 
without code using Zaps. Zaps consist of a 
trigger (an event that initiates a workflow) 
and an action (an event Zapier automatically 
performs for you after the workflow is 
triggered).

http://www.copper.com
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Here are the most popular Zaps Copper 
customers use:

Zapier also works with Slack, Mailchimp, 
Intercom and thousands of other apps. The 
opportunities to save hours on routine tasks 

If you use Google Forms to qualify leads, Zapier 
can automatically add them to Copper. To create 
a brand new lead in Copper for each form 
submission, use this zap.

Zapier also works with more complex 
workflows. If someone fills out a form, and you 
want to first check if they’re already in Copper 
as a person or lead and update their existing 
record, check out this Zapier Playbook.

1 2

When your team’s out networking at trade 
shows, take information scanned from business 
cards into a spreadsheet. Then use this Zap to 
automatically push their contact information 
into Copper.

You can even deliver automatic updates to your 
team in Google Chat when an Opportunity 
closes. Try out this Zap to auto-send out a chat 
message.

3 4

are endless. Just think of what your team can 
do with that extra time.

http://www.copper.com
https://zapier.com/apps/copper/integrations/google-forms/15608/create-copper-leads-from-new-google-forms-entries
https://community.copper.com/zapier-integrations-59/zapier-playbook-update-or-create-lead-person-from-google-form-submission-539
https://zapier.com/apps/copper/integrations/google-sheets/9510/create-copper-opportunities-from-new-google-sheets-spreadsheet-rows
https://zapier.com/apps/copper/integrations/google-chat 
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Copper and Google:  
Work the way you want to.

We’re committed to continually 
strengthening Copper’s Google integration 
so our customers can easily work 
uninterrupted out of their Workspace apps. 
As Workspace evolves along with the future 
of work, Copper will walk in step, helping our 
customers build lasting relationships through 
the Google ecosystem.  
 
Copper is the Google-recommended CRM 
for businesses that grow through strong 
relationships. Visit us at copper.com.

Communication and collaboration tools 
that can integrate with each other to 
more naturally capture the nuances of 
IRL relationships, keep teams connected, 
and increase productivity are vital to your 
success. Companies can maintain a leg up 
when they foster and preserve: the unique 
human culture that develops among its 
employees; the effervescence of creative 
innovation that comes from collaboration; 
and the adaptability to go with the flow while 
prioritizing the wellness and needs of team 
members.

http://www.copper.com
http://copper.com

